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Description 

Revit MEP software for electrical engineering is all about coordination. Yes, it does modeling in 
3D; but the biggest benefit for electrical is not that it can model 3D lights. Rather, it’s that it 
produces a coordinated model with the assurance that everything is circuited and documented 
correctly. Setting up Revit MEP for electrical can be painful. There are many pesky settings and 
things that just do not work the way you want them to work. Come to this class to discuss the 
major items that keep electrical engineers up at night trying to configure Revit MEP to work the 
way they want it to. We’ll tackle problems such as editing panel schedules, changing graphics of 
nested families, creating circuit paths, developing powerful electrical schedules, working with 
hosted fixtures, and working with load classifications. Don't let Revit MEP get the best of you. 
Learn how to fix these pesky settings before they drive you crazy. 

 

 

Speaker(s) 

Mike Massey graduated from Texas A&M University with a degree in architecture. He has 27-plus years 
of experience working in the architecture, engineering, and construction (AEC) industry. Since joining 
Applied Software Technology, Mike has been specializing in Building Information Modeling (BIM) 
implementation for architects and MEP (mechanical, electrical, and plumbing) engineers. Mike is an 
Autodesk Certified Instructor with Professional Certifications in Revit Architecture, Revit MEP (Electrical) 
and Revit MEP (Mechanical). Mike is a repeat speaker at Autodesk University and won the Top Speaker 
award at Autodesk University 2016. Mike has also been a contributing author for Autodesk Official 
Training Courseware. 

 

 
 

Learning Objectives 

 Know how to create powerful electrical schedules 

 Know how to define the circuit path in Revit 2018 

 Know how to work and configure electrical panel schedules 

 Know how load classifications and demand factors are applied 
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Introduction  

For an Electrical Engineer, Revit not only produces construction documents, it should also be 
used to assist as a design tool.  Revit has many tools built into the program to assist in 
coordinating circuits, panels, and schedules to ensure that the entire project is coordinated.  To 
begin using Revit effectively, certain steps must be taken to ensure that the program is using 
the correct graphics or standards to match the firm’s standards.  Most of the settings that will be 
discussed in this session can and should be set up in a Revit template file so each project is 
started with the correct settings. 
 
Throughout my career, I have assisted many Electrical Engineers in setting up Revit to work 
effectively for their specific firm.  I have come across many questions in this process that are 
essential in this process and that is what this class is all about.  This class will discuss and show 
how to solve some of the many questions that I have been asked while I was assisting in setting 
up Revit for different firms. 
 

Working with Light Fixtures 

Converting a ceiling hosted family to a face hosted family  
 
When families are created, a family template is chosen to begin the family.  There are multiple 
family templates that can be chosen when the family is started.  The family templates are either 
hosted or non-hosted.  If the family is hosted, then the family must be attached to another object 
in the model.  The hosted family templates can be Wall, Floor, Ceiling, Roof, or Face hosted.  If 
a wall, floor, ceiling, or roof is used then the family must be attached to a live wall, floor, ceiling, 
or roof.  The family will not recognize a linked wall, ceiling, floor or roof.  Most of the time 
Electrical Engineers will be attaching families to faces inside a linked architectural model.  
Typically Electrical Engineers will not have live walls, ceilings, floors, or roofs; they simply use 
the linked architectural model to represent the walls, floors and roofs. 
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The face hosted family templates allow the family to be inserted onto any face.  A face is simply 
a surface.  A surface could be live in the MEP model or could be inside the architectural linked 
model.  This allows families to be attached to any surface.  It is preferable to have all hosted 
MEP families to be face hosted as opposed to wall, ceiling, floor or roof hosted.    
Most of the out of the box hosted families that come with Revit are created using a face as the 
host, so they can be hosted to linked surfaces.  When content is downloaded from the internet, 
this is not always the case.  It is not an easy change if a hosted family needs to be changed 
from being hosted from a wall, ceiling, floor or roof to a face based host.  The recommend fix is 
to recreate the family using a face based template.  
 
There is an easier fix, one that I actually discovered by accident.  If the family is copied into your 
project by using the Copy/Monitor command, it will change the host to a face based hosted 
family.  This can be done by creating a file and inserting the family hosted to a wall, ceiling, floor 
or roof and then linking that file into another project using the Link Revit command.  Once the 
file is linked, perform a Copy/Monitor command and copy the desired family.  Once the family 
is copied, it becomes a face base hosted family.  The family can then be saved out as a new 
family.   
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Placing Hosted Lights without a Face (Ceiling) 
 
Even with Face hosted fixtures, a surface is required.  If the need arises where a fixture needs 
to be placed prior to the surface being modeled, or if a fixture needs to go into an area without a 
surface (as in an exposed structure ceiling), this can be accomplished by using the place on a 
Work Plane option.   A Work Plane is created by either a Level Line or a Reference Plane.  A 
Reference Plane can be added by going into a Section or Elevation View and using the Ref 
Plane command.   
 

 
 
The Ref Planes inside of Revit have a top and a bottom associated with them, although it is not 
called out as you create it.  If a Reference Plane is created by drawing the plane from left to 
right, the top will be on the bottom.  The correct procedure is to draw the Reference Plane from 
right to left.  This will put the top on the top.  If the plane is drawn incorrectly the lights that are 
hosted to the Reference Plane will be attached upside down.   
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If the lights are upside down, the light fixture family has a flip grip that can be clicked to flip the 
light to be right side up.  It is important to ensure that the lights are right side up so the light 
shines into the space below.  
 

 
 
Reference Planes can be named as well.  It is important to name the Reference Plane so it can 
be identified when trying to select it when the light fixture is being placed. 
 

 
 
To use the place on Work Plan option for a hosted fixture family, you can select it off of the 
ribbon once the Light Fixture command is started.  Once you pick Place on Work Plane, you 
can then use the drop down on the Options Bar to select the Reference Plan by name. 
 

 
 
The light fixture will then be hosted to the Reference Plane and will have the same elevation as 
the Reference Plane.   
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Space not Calculating Foot Candles 
 
When light fixtures are placed into spaces, the space will calculate the average Foot candles for 
the space based on the lights in the space.  The calculation is automatically done as long as the 
lights are in the space.  The space will not calculate the Foot Candles if the lights are outside 
the Space or if the lights are linked into the Revit model.   
 
It is important to understand that Spaces are 3-dimensional spaces.  The heights of Spaces are 
set by assigning a height to the Limit Offset parameter.  The default height for spaces is 8’-0”.  
If the ceiling is higher than 8’-0”, this should be changed to match the ceiling height.  To 
determine the height of the ceiling, a section can be cut through the space.  
  

 
 
Once the ceiling height is determined, the Limit Offset can be assigned, or the top grip of the 
space can be dragged above the ceiling to raise the height of the space up.  The ceiling is a 
Room Bounding object, so the space will stop at the ceiling even if the top grip is raised higher 
than the ceiling.  Once the space height is changed, the Foot Candle load should be indicated in 
the properties of the space.   
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Another way to ensure that all lights are in the space is to use the Room Calculation Point in 
the family of the light fixture.  The Room Calculation Point is now in all families (which is a new 
feature) but is turned off by default.  To turn on the Room Calculation Point, the family needs 
to be opened and then the check box checked in the Properties for Room Calculation Point.  
  

 
 
Once the Room Calculation Point is turned on, a movable point will be indicated in the family.  
This point can be moved to the underside of the light fixture so that when loaded into the project 
it is in a space.  When the light fixture is loaded back into the project with the Room 
Calculation Point turned on, the space will calculate the Foot Candles as long as the Room 
Calculation Point is inside of the space.  This will allow lights to be outside of the space, but 
have the Foot Candles be calculated.   
 

 
 

  



 
 

 
Page 9 

Creating Key Schedules for Lighting Loads 
 
A Key Schedule is defined as a schedule set of keys that will be used in another schedule.  A 
good way to assist in determining if enough light has been provided in a particular space is to 
set up a Key Schedule of common space types with desired foot candle levels.   

 
A Key Schedule can be created by starting a new Schedule/Quantity.  Spaces will need to be 
selected as the Category.  Then change the radio button to Schedule Keys.  Verify the Key 
Name, this will be used later in the space schedule once the Key Schedule is complete.  Then 
select OK to begin making the schedule.   
 

 
 
On the Fields tab, you will notice that the Key Name is already been assigned to the Schedule 
Fields section.  One additional field will need to be created by using the New Parameter button 
in the center of the dialog.   
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The new parameter can be named Desired FC.  The Discipline needs to be set to Electrical 
and the Type of Parameter set to Illuminance.  Then select OK to finish creating the 
parameter.   
 

 
 
No other settings need to be changed in the Schedule Properties.  Select OK to let Revit build 
the schedule. 
 
The Schedule does not initially have any data rows.  Data rows can be added by clicking the 
Insert Data Row button on the Modify Schedule/Quantities tab.  Insert enough data rows for 
the desired number of typical space types.  Then type over the Key Names values for the 
desired typical space names.  Type in the Desired FC for each space type.   
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The Key Schedule will be used in a Space schedule.  To create the Space schedule, select the 
Schedules button on the View tab and then select Schedule/Quantity.  Spaces will need to be 
selected as the Category. Verify the radio button is set to Schedule Building Components.  
Then select OK to begin building the schedule. 
 
On the Fields tab, add the following parameters; Level, Number, Name, Space Style, Area, 
Average Estimated Illumination, and Desired FC.  Then select the Add Calculated Value 
button in the center of the dialog to create a new calculated value parameter.  Type in Delta FC 
as the name of the parameter.  The Discipline needs to be set to Electrical and the Type of 
Parameter set to Illuminance. For the Formula, type in Average Estimated Illumination – 
Desired FC and then select OK to finish creating the calculated value.   
 

 
On the Sorting/Grouping tab, change the Sort by to Number.   
 
On the Formatting tab, select the Delta FC parameter and then pick the Conditional Format 
button.  In the Conditional Formatting dialog, change the Test to Not Between and type in the 
values of -50 fc and 50 fc.  Pick on the Background color button and select Yellow as the 
color.  Select OK to finish the Conditional Formatting.   
 

 
Select the OK button to finish building the schedule.  Verify that the Delta FC for all spaces that 
are not between -50 fc and 50 fc are highlighted Yellow.    
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Working with Equipment Families 

Adding Panel Names to 3D Views 
 
Adding the panel or equipment name to the face of equipment families can be beneficial when 
viewing the model in 3D or when exporting the model to Navisworks.  This will make it easy to 
know exactly what the equipment name is without having to tag it or look at its properties.  To 
accomplish this, Model Text can be added to the family that automatically calls out the Panel 
Name.   

 
Begin by selecting an electrical equipment and then selecting the Edit Family button on the 
Modify tab.  This will open the family for editing.  In the family, switch to a 3D view and zoom up 
on the face of the equipment where you want to place the Model Text.  On the Create tab, 
select the Set button to set the work plane to the face of the equipment.  In the Work Plane 
dialog choose Pick a Plane and then select OK.  Then select the face that you would like to use 
to place the Model Text.   
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On the Create tab, select the Model Text button.  Type in a set of characters to represent the 
number of characters that will be in the Panel Name and then select OK.  Place the Model Text 
by picking the face of the equipment.   
 

 
 
Once placed, select the Model Text to change its properties.  With it selected, change the 
Depth to ½” and change the Horizontal Align to Center, then select Edit Type to open the 
Type Properties.  In the Type Properties dialog, change the Text Size to 3” and select OK to 
close the Type Properties dialog.   
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On the Manage tab, select the Object Styles button.  In the Object Styles dialog, select the 
New button to create a new Subcategory.  Type in Equipment Name as the new 
Subcategory and select OK twice to close both dialogs.  Select the Model Text and in the 
Properties, change the Subcategory to Equipment Name.   
 

 
 
In the Material parameter, select the little … button to open the Material Browser.  Duplicate 
the Default material by right clicking on it and picking Duplicate.  Right click on the new 
duplicate copy of Default and select Rename. Type in Model Text as the name.  On the 
Graphics tab of the Material Browser, select the Color for Shading, choose Red as the color 
and then select OK twice to close both dialogs.   
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Select the Model Text and in the Properties, select the Associate Parameter button next to 
the Text parameter to open the Associate Family Parameter dialog.   
 

 
 
In the Associate Family Parameter dialog, select the Panel Name parameter as the parameter 
to associate with the Text and then select OK to close the dialog.   
 
On the Create tab, select the Load into Project and Close button to save and load the family 
back into your project.   
 

Creating Clearance Zones 
 
Clearance zones are open areas around the equipment to maintain free from other objects for 
working on the equipment.  Building Clearance Zones into equipment families is needed to 
ensure that nothing interferes with the clearance when performing Clash Detections.   
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We will use a wall hosted panel as the example.  Begin by selecting an electrical panel and then 
selecting the Edit Family button on the Modify tab.  This will open the family for editing. Since a 
panel is a face hosted panel, we will need to switch to the Front Elevation view to see the top 
view of the panel family.   
 
In the Front Elevation view, select the Reference Plane button on the Create tab.  Draw a 
Reference plane in front of the panel (the exact distance away does not matter).  On the 
Annotate tab, select the Align Dimension button and place a dimension from the front face 
reference plane to the newly created reference plane.   
 
Select the Dimension and on the Modify tab, pick the Create Parameter button on the Label 
Dimension section of the tab.  In the Parameter Properties dialog, type in Clearance Depth 
as the name of the Parameter and change the Type to Instance by selecting the Instance 
radio button, then select OK to close the Parameter Properties dialog.   
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On the Create tab, select the Extrusion button to begin making an extrusion.  In the Edit 
Extrusion sketch, change the drawing tool to a Rectangle.  Draw a Rectangle sketch by 
snapping to the corner of the panel and then snapping to the intersection of the Clearance 
reference plane and the right side reference plane.  After drawing the rectangle, select on all 
four Padlocks to lock the sketch to the reference planes.  Select the Green Check Mark on the 
Modify tab to finish the Extrusion sketch. 
 

 
In the Project Browser switch to the Ref. Level floor plan.  Select the newly created extrusion 
and use the grips to pull the top of the extrusion to align with the top reference plane 
representing the top of the panel.  Select the Padlock to lock the top edge to the reference 
plane.   
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Select the Reference Plane button on the Create tab.  Draw a Reference plane below the 
bottom edge of the panel (the exact distance away does not matter).  On the Annotate tab, 
select the Align Dimension button and place a dimension from the top edge reference plane to 
the newly created reference plane.   
 
Select the Dimension and on the Modify tab pick the Create Parameter button in the Label 
Dimension section of the tab.  In the Parameter Properties dialog, type in Clearance Height 
as the name of the Parameter and change the Type to Instance by selecting the Instance 
radio button, then select OK to close the Parameter Properties dialog.   
 

 
 
On the Modify tab, use the Align command to align the bottom edge of the Clearance 
extrusion to the newly created Reference plane.  Pick the Padlock to lock the extrusion to the 
Reference plane.   
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On the Create tab, select the Family Types button to open the Family Types dialog.  In the 
Family Types dialog, type in 3’-0” for the Clearance Depth.  We will use a formula for the 
Clearance Height.  In the Formula for Clearance Height type in Default Elevation + (Height / 
2). Select OK to close the Family Types dialog. 
 

 
On the Manage tab, select the Object Styles button.  In the Object Styles dialog, select the 
New button to create a new Subcategory.  Type in Clearance as the new Subcategory and 
select OK to close the New Subcategory dialog.  Change the Line Pattern for the Clearance 
Subcategory from Solid to Hidden.  Select Ok to close the Object Styles dialog.  Select the 
Clearance extrusion, and in the Properties change the Subcategory to Clearance.   
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In the Material parameter, select the little … button to open the Material Browser.  Duplicate the 
Default material by right clicking on it and picking Duplicate.  Right click on the new duplicate 
copy of Default and select Rename. Type in Clearance as the name.  On the Graphics tab of 
the Material Browser, select the Color for Shading and choose a soft orange color as the color 
and select OK to close the Color dialog.  Change the Transparency of the Shading to 60 by 
dragging the Transparency bar to the right and then select OK to close the Material Browser 
dialog.   
 

 
On the Create tab, select the Load into Project and Close button to save and load the family 
back into your project.   
 

Using Copy/Monitor on Mechanical Equipment 
 
As an Electrical Engineer, you are expected to supply power to the Mechanical Equipment that 
the Mechanical Engineer designs.  Typically, this is a coordination nightmare because you have 
to work with equipment that is provided to you in a link Revit model.  Until Revit allows us to 
create electrical circuits through linked files, this coordination issue will continue.   
 
One possible solution is to take advantage of the Copy/Monitor tool inside of Revit.  You can 
use the Copy/Monitor tool to copy and specify a Type Mapping of the equipment so you can 
create electrical circuits of the equipment.  Typically Electrical Engineers want to show some 
sort of symbol for the mechanical equipment, like a motor symbol.  This can be accomplished by 
using an Electrical Connector family and including a Motor Annotation symbol as the 
graphics.  To accomplish this, the Electrical Connector family needs to be created and loaded 
into the project.  The out of the box Electrical Connector family can be modified.   
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Begin by opening the out of the box Electrical Connector family in the library.  The Electrical 
Connector family is found in the Electrical/MEP/Connectors folder.  You can either use 
Electrical Fixture – Balanced Power Connector.rfa or the Electrical Fixture – Unbalanced 
Power Connector.rfa.  In both of the families, most of the parameters on the electrical 
connector are set to have associated parameters that can be changed in the project.  The 
exception is the Apparent Load parameter.  To associate the Apparent Load parameter, 
select the green Electrical Connector and in the Properties, select the Associate Parameter 
button next to the Apparent Load parameter to open the Associate Family Parameter dialog.   
 
In the Associate Family Parameter dialog, select the New Parameter button to create a new 
parameter.  In the Parameter Properties dialog, type in Apparent Load as the name of the 
Parameter and change the Type to Instance by selecting the Instance radio button, then 
select OK to close the Parameter Properties dialog.    
 

 
Next we will load the Motor Annotation symbol by clicking Load Family on the Insert tab.  
Browse to the Motor Annotation symbol in the Annotations/Electrical folder.  Select the 
Motor Annotation.rfa and the pick the Open button.   
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Place the Motor Annotation symbol by switching to the Ref. Level floor plan in the Project 
Browser.  Then in Project Browser, expand Families, and Motor Annotation by clicking on 
the plus signs.  Right Click on Motor Annotation and select Create Instance.  Then place the 
symbol at the intersection of the two reference planes.   
 

 
On the Create tab, select the Family Category and Parameters button.  Change the Family 
Category to Mechanical Equipment and select OK to close the dialog. 
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On the File tab, select Save As then Family and save the family with the name Motor 
Connector.  Then use the Load into Project and Close button to load the family back into 
your project.   
 
Back in your project, if you don’t have the Mechanical model linked in, use the Link Revit 
command to link the Mechanical model into your project.  Once it is loaded select the 
Copy/Monitor button on the Coordinate tab and then select Use Link.  With your mouse, 
select the linked in Mechanical model as the link to Copy/Monitor from.   
 
On the Copy/Monitor tab, select the Coordination Settings button.  In the Coordination 
Settings dialog, select Mechanical Equipment and change the Copy Behavior to Allow 
Batch Copy and the Mapping Behavior to Specify Type Mapping.   
 

 
Click on the plus sign next to Mechanical Equipment to select the Type Mapping.  In the Type 
Mapping, change the In The Host Model to map to the Motor Connector family.  There will be 
different voltages to choose from.  This can be changed later but if you know which voltage, 
select the correct one.  Select the Save & Close button to close the dialog.   
 

 
On the Copy/Monitor tab, select the Batch Copy button.  In the Fixtures Found dialog, select 
Copy the Fixtures.  In the Levels not set dialog, select Continue Copying Fixtures.   
 
On the Copy/Monitor tab, select the Green Check Mark to finish the Copy/Monitor command.  
Verify that the Motor Annotation symbol was placed in the view where there is Mechanical 
Equipment.  Select the Motor Annotation symbol, and type in the Apparent Load and the 
Mark (the desire name to be used) in the Properties.   
 
The Linked Mechanical model can be turned off in Visibility Graphics.  The Motor Annotation 
symbols can be circuited to panels by selecting the symbols and the selecting the Power button 
on the Modify tab.   
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Creating Electrical Circuits 

Using Filters to Show Un-Circuited Devices 
 
One of the more powerful benefits of using Revit for Electrical is the built in coordination. Tags 
and schedules will be coordinated and you can verify that all devices/fixtures have been 
circuited.  There are several ways to verify if all devices/fixtures have been circuited.  The 
System Browser and the Show Disconnects can be used.  Another way is to create a color 
coded plan to color all devices/fixtures that are not circuited or circuited but not assigned to a 
panel.  This will allow you to easily visualize what needs to be connected.  Filters can be 
created to achieve this color coded plan. 
 

 
To create the filters, select the Filters button on the View tab.  In the Filters dialog, two filters 
will be created.  Select the New button and type in Electrical Check – Not Circuited as the name 
and select OK to close the Filter Name dialog.  In the Categories section, Check the Electrical 
Fixtures, Lighting Devices, Lighting Fixtures, and the Mechanical Equipment categories.  
In the Filter Rules, change the Filter By to Circuit Number, Is Less Than, and type in 1 as the 
value.   
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Select the Duplicate button, and then select the Rename button.  Rename the duplicate filter to 
Electrical Check – Circuited but not assigned to a Panel and select OK to close the Filter 
Name dialog.  In the Filter Rules, change the Filter by to Panel, Equal, and leave the value 
empty.  Select OK to Close the Filter dialog.   
 

 
Next the Filters will be assigned to the view.  This is done by selecting Visibility/Graphics on 
the View tab.  In the Visibility/Graphics dialog, select the Filter tab.  On the Filter tab, select 
the Add button.  In the Add Filters dialog, select both Electrical Check filters and select OK to 
close the Add Filters dialog.   
 
Change the color for both filters by selecting the Override button for Lines and Patterns.  
Choose a color and the solid pattern.  Select OK to close the Visibility/Graphics dialog. 
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Viewing and Modifying Circuit Paths 
 
Revit has always created a Length parameter for circuits.  This Length parameter is used in 
the Voltage Drop calculation.  The problem has been you were not able to see the path that it 
was taking to calculate the length of the circuit.  New in 2018 is the ability to view AND modify 
the circuit path.  Any modifications to the path will automatically update the Circuit Length and 
the Voltage Drop calculation.   
 
To view the circuit path, the circuit must be selected.  To do this, select one device/fixture that is 
part of an existing circuit.  With it selected, switch to the Electrical Circuits tab on the menu.  
With the Electrical Circuits tab selected the Properties Palette automatically changes and 
shows the properties of the circuit, where you can view the Circuit Length and the Voltage 
Drop parameters.   

 
On the Electrical Circuit tab, select the Edit Path button.  This will display the default path, 
which is defaulted to show the path going to All Devices.  You can modify this default path 
simply by selecting on a path line and moving it, changing the elevation of the path line.  
Additional Control Points can be added or removed by right clicking on a path line.    
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If desired, you can change the path calculation from All Devices to Farthest Device.  This will 
draw the path from the panel to the farthest away device.  This path can be modified as well.   
 

 
When finished viewing or modifying the path, click the Finish Editing Path check mark.  The 
updated path will be used in the Circuit Length and the Voltage Drop calculation.   
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Working with Panel Schedules 

Load Classifications and Demand Factors 
 
Panel schedules will calculate the Total Est. Demand for the panel based on Load 
Classifications and Demand Factors.  The load is calculated automatically on the default 
template.  It is important to understand how this is calculated to ensure that the load is correct.  
  

 
 
To understand how Revit calculates the Total Est. Demand, there are two settings that need to 
be reviewed.  These are the Demand Factors and the Load Classifications.  Both of these 
settings can be found on the Manage tab in the MEP Settings drop down.  Let's first look at the 
Demand Factors and then we will look at the Load Classifications.  
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The Demand factors allows you to add, delete, or rename demand factors.  The factors that 
are in the template initially are based off of the NEC.  Each of the demand factors can calculate 
the demand based on Constant, By quantity, or By load.  These can be modified to meet your 
specific project needs.   

 
The Load Classifications are similar in name to the Demand Factors.  Each Load 
Classification can be modified to point to use a particular Demand Factor.  The Load 
Classification also assigns whether the load is a lighting load or a power load.  The Load 
Classifications can be renamed, deleted, or new ones can be created.   
 
The Load Classifications are then assigned to electrical devices or fixtures.  All electrical 
devices or fixtures will have a Type Parameter that will allow you to specify which Load 
Classification that type is assigned to.  Once the Load Classification is assigned to the 
device or family, the default schedule will automatically begin calling out the loads and 
calculating the loads based on the Demand Factor.   
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Load Names in Panel Schedule 
 
When creating circuits in Revit, Revit will automatically give the circuit a Load Name in the 
panel schedule in the Circuit Description.  The default load name is defined by the Load 
Classification, the Space Name and the Space Number.   

 
 
If the space name or number is changed after the circuit has been made, the Load Name can 
be updated by using the Update Names button on the ribbon when in the Panel Schedule 
view.  If the circuit spans across multiple spaces, the Load Name will use the Load 
Classification and the Space Numbers. If the rooms have the same name, then the Space 
Name will be included in the Load Name.  If desired, the entire Load Name can be typed over 
to use the name of your choice. 

 
 
The Load Classification is assigned in the Type Properties of the fixture or device.  Revit 
comes with many Load Classifications to choose from.  Additional Load Classifications can 
be added by adding them to the settings in the MEP Settings.   
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Getting Panels to Number down instead of across 
 
By default the electrical panel numbers the circuits across as opposed to down.  This method is 
acceptable by many but some would prefer have the circuit numbers go down.  If you look at the 
electrical settings and examine the Panel Templates you will not find a way to change the 
numbering system. 

 
 
It is a very simple change once you know how.  To change the numbering system you need to 
open the family of the electrical panel.  Once the family is opened, you will see a Panel 
Configuration parameter in the properties.  Use the drop down next to this parameter and 
change it to Two Columns, Circuits Down and reload the family back into your project.  It will 
automatically change the numbering system for the panel schedule.  If this is your preferred 
method, you should modify the electrical panel and load this panel back into your Project 
Template so every project is set up to number the circuits down.   
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Panel Schedule Templates 
 
When creating an electrical panel you can use the default template select from the list of 
templates, or a customized template.  The templates in your project are managed by the 
Template manager.  This is where you can define which template is your current default.  You 
can also create new templates or copy an existing template to make a new one.   
 

      
 
If you need to edit a template you can select Edit and it will open up the Panel Schedule 
Template.  Modifying the template is similar to working in Excel.  You can create new columns 
or rows, and assign them to use certain parameters.  You also have complete control over the 
graphics, fonts, and spacing of the cells.  There are a multitude of items that can be changed to 
meet your company standards.   
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One of the common questions I have been asked is "how do you create a double panel for an 
84 circuit panel?"  The simple answer is Revit cannot do that, but... like other limitations in the 
program, there are workarounds to make Revit do what you want it to do.   Revit will allow you 
to have as many circuits as you desire.  The problem is that many people want to create the 
second panel schedule with the numbers starting at 43 (having the first 42 on the first panel).  
Revit will not allow you to begin the numbering system with anything other than 1.   
 

 
 
There may be other workarounds, but the one that I have found to work the best is to create two 
customized panel templates and then when the panels are placed onto the sheet, one panel 
would be place inside of the other panel.   
 
The first custom panel needs to be set so that the number of slots shown is variable.  This can 
be set in the template settings.  You then need to add 3 blank rows between the last circuit and 
the branch totals.  The first blank row will be used to place text indicating the second panel.  The 
second blank row will be used to call out the column headers for the second panel.  The third 
blank row will be used to as a place holder for the second panel when the panels are placed 
onto the sheets.  The third row needs to be modified to change the height of the row.  The 
height needs to set to the height of the 24 circuit rows.  You can do the math to multiple the 
height of 1 row times 24 to get the height.   
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The second custom panel needs to be set to a constant value of 84 circuits.  This panel will 
require more changes than the first panel.  You will need to delete the bottom rows that are 
defining the Load Calculations.  You will then need to change the graphics of the first 42 circuit 
rows to be white in color.  The headers of the rows can be changed to use a ghost font.  A ghost 
font is a font that is not visible.  You can download a ghost font off of the internet if you do not 
have one available.   Essentially we are trying to create a schedule that calls out only the circuit 
rows of the last 42 circuits and nothing else.   
 
You can now go ahead and create the panel schedule for the first panel using the first template.  
Prior to creating the schedule you need to select the panel and change the Max #1 Pole 
Breakers to 48.  This will allow you to create a three circuit connection of the second panel on 
circuits following 42.  A circuit needs to be created from the second panel to the first.  This 
circuit needs to be moved to circuits 42, 45 and 47.  Once it is moved, the circuits should be 
locked so they do not move.   
 
The second panel schedule is created using Default template.  We will change this to use the 
second template after we lock down the first 42 circuits.  To lock the first 42 circuits you will 
need to assign spares to the first 42 circuits. This will make the first available circuit be 43.  
Once the spares have been assigned, you will apply the second template to this schedule.  
When the second template is assigned the first 42 circuits become ghosted. 
The panels are now ready to be placed onto the sheets.  You will place the first panel and then 
place the second panel.  The second panel will need to be moved to occupy the blank space in 
the first panel.  Panels do not have snaps, so this will have to be done by zooming up and 
nudging the panel into place.   
 
The first panel is picking up the loads from the second panel.  The first panel is adding the loads 
and giving the total demand from both circuits.  This is a 'workaround' but it works nicely once it 
is set up.  As with most custom configurations, I recommend that this is done inside of your 
Project Template so it is set up and ready to be used on all projects.   

 
 

Using Schedules to check if Main is Sized Correctly 
 
Revit does a great job in keeping items coordinated.  One of the few things Revit does not do is 
ensure that the Mains on electrical panels are sized correctly.  Electrical panels have a 
parameter called Mains that the users are supposed to type in once the panel size is known.  It 
would be nice if Revit could look at the load on the panel and size the main accordingly, but it 
does not do that.  One way to assist in making sure the Mains are sized correctly is to use 
Conditional Formatting on an electrical equipment schedule.   
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Begin by selecting Schedules and then Schedules/Quantities on the View tab to create a new 
schedule.  In the New Schedule dialog, select Electrical Equipment as the Category.  Verify 
or change the Name of the schedule and select OK to begin building the schedule.   
 
In the Schedule Properties on the Fields tab, add the following fields: Family, Panel Name, 
Supply From, Electrical Data, Total Connected, Total Connected Current, and Mains.  
Then select the Add Calculated Value button in the center of the dialog to create a new 
calculated value parameter.  Type in Main Delta as the name of the parameter.  The Discipline 
needs to be set to Electrical and the Type of Parameter set to Current. For the Formula, type 
in Mains – Total Connected Current and then select OK to finish creating the calculated value.   

 
On the Filter tab, use a filter to filter out electrical equipment that are not panels by using a 
common parameter.  One possible filter is to Filter By: Panel Name Contains P. 
 
On the Sorting/Grouping tab, change the Sort By: to Family. 
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On the Formatting tab, select the Main Delta parameter and then select the Conditional 
Formatting button.  In the Conditional Formatting dialog, change the Test to Not Between 
and set the values to be 0 A and 100 A.  Select the Background Color button and select 
Yellow as the color.  Select Ok to close the Conditional Formatting dialog.  Select OK to 
close the Schedule Properties dialog.   

 
Working with Nested Families 

Nested families are used for many of the electrical devices in Revit.  A nested family is simply a 
family that has another family inside of it.  Many of the devices that are ‘out of the box’ are 
created this way.  The nested family is usually a Symbol Family that shows the 2D graphic 
representation of the device that we see in a plan view.  It is specifically a symbol family 
because symbol families will change scales based on the scale of the view that they are visible 
in.  This allows our symbolic graphic to always be legible and not just a tiny dot, or too large as 
we change the scale.  
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Correcting Upside down Switch Labels 
 
The most asked question that I have received is about the Lighting Device symbol.  When using 
this symbol, there are multiple types to indicate what type of light switch is needed to be shown.  
Some of the types included with the family are: Single Pole, 3 way, 4 way, Dimmer, Timer, etc…  
  

 
 
The family uses a label to indicate which type is being used.  The question that I am typically 
asked is about the label when the family is inserted onto a wall, and the switch is facing down in 
a plan view.  The label is upside down.  How do you rotate the label so it is not upside down?   

 
This is a simple fix once it is understood that the label is part of a nested symbol family.  To 
correct this, simply click on the switch family and then select Edit Family from the Modify tab.  
This will open up the family in the family editor.  Once inside the switch family, change your view 
to the Ref. Level plan view.  In the plan view, the symbolic nested family will be visible.  Select 
the nested symbolic family and the select Edit Family from the Modify tab again to open up the 
nested family.   
 
Inside the nested symbolic family, all that needs to be changed to fix the problem is a check box 
in the properties.  Check the box for the parameter “Keep Text Readable”.  
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Once the check box is checked, all that is remaining is to load the families back into each other 
and then load the family back into your project.  Since it is a nested family, be sure to first load it 
back into the Lighting Switch family first, and then load the Lighting Switch family back into your 
project.   
 

Creating Stacked Devices 
 
Another common question I receive concerning nested symbol families is how to show multiple 
devices that are in the same location in plan view but are stacked above or below other devices.  
For example, multiple receptacles that are at different elevations.   
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In the CAD world, this would be indicated by moving the receptacle symbol out from the wall with 
a height adjacent to the symbol to call out the elevation height.  The big difference between CAD 
and BIM is that in BIM you need to model the receptacle in the correct location to allow for clash 
detection, so you cannot just move the symbol.   

 
This can be accomplished by modifying the nested symbol family to allow for the graphics of the 
symbol to be moved while keeping the 3D geometry of the receptacle in the correct location.  To 
do this you will need to add a location parameter that is associated with a dimensional 
parameter to move the graphical symbol away from the wall.  
 

 
The label on the symbol family can be used to indicate the height of the receptacle.  This will 
keep your receptacle family readable and allow stacked devices. 
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Additional Topics 

Changing the Graphics of a Light Fixture 
 
Light fixtures are indicated on plans by using a symbol in plan view to distinguish them from 
other light fixtures.  The graphics that represent the light fixture often need to be customized to 
match office or project standards.  To change the graphics of a light fixture, it is important to 
understand that the light fixture families are created with four main parts.   
 

 
All light fixture families consist of 3D geometry, a light source, an electrical connector, and 2D 
line work.  The 3D geometry is what is seen if you are viewing the fixture in 3D, section, or 
elevation.  It is typically parametric in that it allows the dimensions to be modified to create 
multiple types and sizes.   
 

 
The light source is the intelligent information that is used to indicate the type of lamp and the 
photometric of the fixture.  Manufacturers can typically supply a photometric file in the form of an 
.ies file.  All light fixture families and point to the appropriate photometric file to indicate the 
correct light source information. 
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The electrical connector contains the information that is needed to circuit the light fixture.  The 
electrical connector will have both load information and voltage.  The load and voltage can be 
changed to meet your project needs.   
 
Finally, the 2D geometry is the linework that is indicated on plans and reflected ceiling plans.  If 
the 2D geometry needs to be changed to meet office standards, this can be done without having 
to change the 3D geometry.  If the family is edited, the 2D linework can be seen in either the 
plan view or the ceiling view.  The linework can be deleted and/or new linework can be added.  
When modifying the 2D linework it will not affect the 3D geometry.  The 2D linework will 
probably need to be locked to the reference planes so it will flex with the family when new sizes 
are required.   

 

Changing the Origin of a Light Fixture 
 
Going back to my CAD days, I always taught my users to make the insertion point for blocks in 
the lower left corner of the block.  This would keep consistency when inserting the blocks and 
allow you to snap to intersections to locate them correctly.  Moving to the BIM world, the same 
logic applies.  It is important to create consistency when creating families, by making the 
insertion point in the lower left corner of the family. 
 

 
 
The insertion point of families is defined by defining the origin of the family.  When a family is 
started from using a family template, the family will start with two reference planes.  The 
intersection of these two reference planes defines the origin, or the insertion point.  If the family 
is created with the intersection of the reference planes in the center of the family, then the 
insertion point will be in the center of the family.  If the family is created using the reference 
planes as the lower left corner, then the insertion point will be the lower left corner. 
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Existing families can be modified to change the origin by modifying the family.  Reference 
planes can be selected.  When they are, one of the parameters in the properties is Defines 
Origin.  If a reference plane does not exist where the desired origin needs to be defined, then a 
new reference plane can be drawn, and the Defines Origin parameter can be checked to 
define the new reference plane as the origin.  If reference planes do exist where the desired 
origin is required, then the reference plane can be selected and the Defines Origin check box 
can be checked to change to origin to the new plane.  Both the horizontal and the vertical 
reference plane need to have the Defines Origin check box check to define the intersection of 
the two reference planes as the origin.  Reference planes should be dimensioned or locked to 
the geometry so the planes will move if the family is modified to a new size.   
 

Double Homeruns 
 
Circuits are created by creating a Power System for the electrical devices or fixtures, and then 
selecting the electrical panel that will host the circuit.  Once the circuit is created, wires can be 
drawn to indicate the wiring layout for the circuit.  The wires do not make the circuit.  The circuit 
is made by creating the Power System.  Wires do not have to be drawn if they are not needed.  
If wires are drawn, Homeruns can be indicated for the circuit by drawing a wire from a circuited 
device or fixture and then picking a point other than another device or fixture.  Homeruns can 
also be tagged to indicate the circuit number and/or the electrical panel name.   
 
If a Double Homerun needs to be indicated, this can be done by dragging a homerun from one 
circuit to a fixture or device on a different circuit.  As soon as the home run has been dragged to 
the other fixture or device, the home run on the second circuit will change and indicate the 
double home run by adding an additional arrow head to the home run, and adding an additional 
tick mark.  If the home run is tagged, the tag will be updated to call out both circuits.   
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In previous releases of Revit, there was a graphical error that bothered many users.  The 
homerun that was dragged to the fixture or device on the other circuit would keep the initial 
arrow head as opposed to removing the arrow head.  
  

 
This graphical error could be fixed by duplicating the view with detailing.  Once the view is 
duplicated, the extra arrow head on the first circuit is deleted.  This workaround works for 
releases prior to 2014.   
 

 
 
In 2014, it appears that this has been fixed.  Performing the same steps in 2014, the extra arrow 
head is not indicated on the first circuit.  This fix is undocumented and occasionally does not 
work.  So if, you need to delete the unwanted arrow head, you can fix it by duplicating the view 
with detail.     
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3 Most Important Parameters when Inserting Panels 
 
There are three important parameters that should be checked or changed when inserting an 
electrical panel.  One of these is mandatory prior to creating circuits on the panel.  After 
inserting a panel, the Distribution System must be assigned.  Revit will not allow anything to 
be connected to the panel until the Distribution System has been assigned.  The Distribution 
Systems are defined in the Electrical Settings.  The Distribution System is assigned by 
using the drop down on the Options Bar.  By default it is initially set to None.   
 

 
The second parameter that should be changed is the Panel Name. This parameter is found in 
the properties of the panel.  Once the Panel Name is added, the panel can be tagged to 
indicate the Panel Name.  

 
The third parameter that is recommended to change is the Max #1 Pole Breakers.  The initial 
value is set to 12.  If this is left alone, the panel can only hold 12 circuits.  When the 13th circuit 
is created, the panel will not be able to be selected for the circuit.   
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The Max #1 Pole Breakers also defines the height of the panel box.  As the number of circuits 
is changed, the height of the panel is changed.  This is indicated in the Type Properties of the 
panel.   
 

 
Conclusion 

Using Revit for electrical is extremely powerful.  As I stated in the beginning, it is not the fact 
that it is modeling in 3D that is important to electrical, it is the coordination that it does to ensure 
that our documents are picking up everything.   
 
Can you use Revit right out of the box?  The answer to this would be determined if you are able 
to accept the default graphics, settings, and content.  Many engineers do use it without any 
customization, but knowing how to customize it to fit your company standards makes Revit even 
more powerful. 
 
Most everything that has been discussed in this class can and should be set up in your project 
template so it is available in all projects that are started.  The Project Template is never finished.  
I have heard some companies hesitant to start using Revit until their Project Template is 
complete.  New settings, standards, and content always need to be added to your template.  
The Project Template is a work in progress.   
 
I hope you have picked up a new tip, trick, or idea from this class.  Revit is a powerful tool and 
knowing how to use it correctly is important. 
 
 
 
 


